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1. Preface 
Central Manager System(CMS) is a powerful remote manager system. It can allow 
administrator to manage video recorders through network located in different sites 
from one point of control. 
 

Each CMS system can manage up to 64 sets of video recorders with maximum 4096 
channels. You can monitor, playback, backup the video files from the video recorders 
through network at any time. You can also proceed to set up the remote system 
configurations. 
 
With user friendly GUI, administrator can monitor the video recorders very easily. 
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2. Installation 
CMS can serve up to 64 sets of video recorders (4096 channles) including DVR, 
Hybrid DVRs or NVRs at the same time. Before the installation, make sure your 
computer meets the following minimum requirement for connecting video recorders. 
 
CMS supports DVR, Hybrid DVR and NVR firmware versions,  

Product Product Firmware Version 

DVR 
V3.60, V3.81, V4.00, V4.20, V4.23, V5.00, V5.01, 
V5.02, V5.06, V5.20, V6.00, V6.20, V6.30, V6.40, 
V6.61 , V7.40 and V7.43 

Hybrid DVR FV5.06, FV5.20, FV6.00, FV6.20, FV6.30, FV6.40, 
FV6.61 and  FV7.40  

NVR NV5.06, NV5.20 NV6.00, NV6.20, NV6.30, NV6.40, 
NV7.40 and NV7.43 

 
 

CMS Requirement�

OS Windows 7 Ultimate 32bit 
WinXP Professional 32 bit SP1/SP2/SP3  

CPU Core 2 Duo 2.5G and above  

Display Card 
*Intel On-board VGA 
*Nvidia – 7xxx series, 8xxx series VGA card 
*1024*768 screen resolution 

RAM 2GB and above 

Hard Disk 250 GB and above (System files and Backup files 
should be in the same HDD section)  

Network Card 10/100/1000Mbs 
Mouse PS/2 or USB compatible 
DVD-ROM General 
USB Interface 1.1 / 2.0 
DirectX V7.0 & above 
 
For connecting to DVR V5.10 and above versions, two hardware components should 
be upgraded as below, 

CMS200 Requirement�
CPU Intel Core 2 Duo E6300 1.86G and above 
RAM 1G and above 
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2-1. Install CMS 

Before you install CMS 3.42, please make sure if your PC system is already installed 
"Microsoft .Net framework 3.5". If not, please go to the following website 
"http://download.microsoft.com/download/5/6/7/567758a3-759e-473e-bf8f-52154438
565a/dotnetfx.exe" and download "dotnetfx.exe" to your PC system. Execute this 
program and now you can start to install CMS200 V3.42. 
 

� Step 1 Insert the installation CD.  
� Step 2 Then, go to the directory to run the Setup.exe and follow the steps. 

When finishing the setups, it will show up the message.  

Then, you can find the “Central Manager” folder and its sub menu from the 
Windows Start menu. 

 

 

1. Tools 
� Backup Information Tool 

    By using this tool, you can get the information of backup file. Please refer to the 

Chapter 4-11 Central Backup for the backup configuration. 

 
� Setup 

You can change CMS operation language in this menu. 

 
 
CMS runs in Microsoft Windows platform. When CMS is activated, it will detect 
the Windows Language version and automatically switch CMS operation 
language with other language options according to the rule described in 
following table.  
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Microsoft Window 
Language version 

Default CMS 
Operation Language 

Language Options  

English English English 
Traditional Chinese Traditional Chinese English, Traditional Chinese 
Simplified Chinese Simplified Chinese English, Simplified Chinese 
Japanese Japanese English, Japanese  
French, German, 
Polish, Portuguese, 
Spanish, Dutch, Russian  

English French, German, Polish, 
Portuguese, Spanish, Dutch, 
Russian 

 
� Multi-Screen 

CMS supports max 16 multiple screen display. The “Multi-screen” option should 
be ticked before you proceed with multi-screen configuration. Please refer to 
“Chapter 4-3-3 Multiple Screen Setup”.3  

 
2. Backup 
CMS Backup function provides users with backing up video files from remote video 

recorders. Please refer to the Chapter 4-11 Central Backup for the backup 
configuration. 

 
3. Central Manager 
Click this icon to start CMS. 
 

4. EMap Editor 
CMS provides EMap function so that user can see the camera locations in the MAP. 
Before enabling this function, user needs to edit his own EMaps in the EMap Editor. 

Please refer to the Chapter 4-8 EMap Editor. 
 

5. Player 
This is a local DVR player. After user downloads the video files from video recorder, 

he can play the files in this player in the Window platform. Please see the Chapter 
4-12 User Local Playback.   
 

6. User Manual: 
You can access the user manual in this folder. 
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3. Profile Manager  

After the installation, start the CMS application by clicking the icon  in the CMS 

folder from the Windows Start menu. The “Profile Manager” will pop up to let the 
user to Create, Delete, Edit, Import, Export, Open “User Profile” or query “Log”. 
 

 
 
First time to use CMS, user has to create a new “User Profile” to save the 

configuration of video recorder. You can create different Profiles for different 
configurations at the same time. Next time when you start the CMS, you don’t need to 
create a new User Profile any more and you just open one of Profile you prefer.   

3-1. Create a New User Profile 

Click “New” on the Profile Manager, it will show the Profile Setup 
Dialog as following  

 
 

Enter the “Profile Name”, “Supervisor Password”(R/W Password), and “User 
Password” (Read only Password) in the Profile Setup Dialog.  
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After the new profile has been created successfully, the new profile icon will be 
shown on the Profile Manager screen as below. 

 
 

 

! 
Note 
� “Profile” name can’t exceed 50 characters. 
� “Profile name” only supports Chinese, Russian & English words and 

does not support special marks. 
� Password can’t to exceed 30 characters. 
� Password only supports numbers, Russian & English character.   

 

3-2. Delete Profile 

If you want to delete the User Profile, click “Delete” button. Then, the system will 

request you to enter the Supervisor password. Only supervisor has the authority to 
delete the Profile.  

 
 

3-3. Edit Profile 

If you want to edit the Profile, just select it and click the “Edit”. The system will 
request you to enter the Supervisor password. Only supervision has the authority to 
edit the Profile. Therefore, enter the Supervisor password. 
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3-4. Import profile 

You can import the backup profile to system. It’s easy for copying the settings 
between computers.  

Click “Import” button, and select the *.bkp file which you want to import. (file 
exported before) 

 
 
 

 
After importing file, the imported file will be added in the Profile Manager screen as 
following,  

 
 

 

3-5. Export Profile 

If you want to back up the profile or execute CMS on another computer but use the 
same profile, you can export the “Profile”.  
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Please choose the profile you want to export and click “Export” button. 
 

 
 

CMS will request you to enter “Supervisor” password. Enter the password and the 
address of the saved profile will show up. You can select the path to save the .bkp file 
which has just been exported, and it will appear on the appointed address. 
 

3-6. Login 

The user can select the created Profile, enter the password and then start to login. 

There are two kinds of password identification-Supervisor and User password. Each 
one has different authority in CMS. The following is comparison tables of the 
authority. 

 
Profile Manager �

New Delete Edit Import Export Login 
Sequencer Monitor 

Options  

Supervisor � �������� �������� ���� �������� �������� �������� ��������

User � �������� �������� ���� �������� �������� �������� ��������

����

Quick Select Tag  
Save Delete Rename 

Full 
Screen Snapshot Setup System 

Status Playback 

Supervisor �������� �������� �������� �������� �������� �������� �������� ��������

User �������� �������� �������� �������� �������� �������� �������� ��������
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3-7. CMS Log Query 

By clicking “Log” tab in the Profile Manager window, you can query any operation 
event on CMS server.    
 

 

 
Report of CMS operation event log. 
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4. Main Screen 
 
When you login the profile successfully, the following monitoring window will 
appear.  
 

 
 

 
 

Date & Time 

Setup 
Motion to Zoom 
Playback 

Sequencer 

Display Mode 

Quick Select Tag 

System status 

Exit 

DVR List 

Minimize & Maximize 

CMS Window 

E-MAP 

Preview Window 

Snapshot 

Full Screen    
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4-1 Main Screen 

After finishing the DVR configuration (refer to 4-3 “DVR setup”), go back to Main 
Screen and it will show the following screen.  
 

 

 

 

Click � button in front of the DVR in DVR List window and it will list all of the 

cameras connected to the DVR. Click any listed camera and the image of this camera 

will be displayed in the “Preview Window”. You can decide if you want to display 
this camera in the Spilt Window. If yes, just click this camera, Drag and Drop it to 
any spilt window you want to display. You can also display all of the cameras in any 
DVR to monitor at one time. Just click the right button of mouse on any DVR in the 
DVR List and it will show the following menu. Select “Add all” and all of the 
cameras connected to this DVR will display to the monitor simultaneously.    

    

 
 

Drag & Drop 

Preview Window 
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Below table shows the description of each function.    
 

Function Description 
Add all One time show all of live images from the designed video 

recorder in the CMS monitor.   
Disable Monitor Stop displaying all of the live images in CMS monitor from 

the designated video recorder.  
Two Way Audio Enable two way audio between video recorder and CMS 

server. Please refer to “Chapter 4-1-5 Two Way Audio”.   
Refresh Connecting Refresh connecting to video recorder  

Stop All Stop displaying all of the live images in CMS monitor  

 

4-1-1 Zoom in/ Zoom Out Adjustment  
You can Zoom in or Zoom out any Spilt window. Double click on any split window 
and it will be enlarged to Single Channel view. You can double click again on this 
enlarged window and it will go back to the original spilt mode.  In Single Channel 
view, you can scroll the mouse to Zoom in or Zoom out the image. There are ten 
display modes “Full, 250%, 225%, 200%, 175%, 150%, 125%, 100%, 75% and 
50%”.  

 
                      Single Channel Mode 

4-1-2 Camera Options 
Click right button of mouse on any channel split window, the screen will pop up a 
menu as below for camera options.  

�
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�

 
The following table is the description for each function.  

Function Description 
Execute -Enable: Enable displaying the camera in the Spilt Window 

-Disable: Disable displaying the camera in the Spilt 
Window 

Motion Detect Enable/Disable Motion Detection function.  

 De-interlace Turn on or off the De-interlace function to adjust live 
image quality.  

 Stop All Stop all of the channel display in the CMS monitor 

 DO Control Remote trigger DO alarm (Please refer to “Chapter 4-1-6 
Remote Trigger DO Alarm”)  

 

4-1-3 PTZ Camera 
If video recorders are installed with PTZ cameras, the PTZ control panel will pop up 

in CMS main monitor while CMS is in Single Channel View for controlling PTZ 
camera remotely. PTZ control functions include “Zoom In”, “Zoom Out”, “Focus 
Near”, “Focus Far”, “Auto-Focus”, “PTZ Speed”, “Go to Preset Point” or “Start/Stop 
PTZ Auto Pan”. 
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� Go to Preset Point 
    According to the PTZ Preset Points set in video recorder, you can directly enter  

Preset point and click “Go” tab so that the PTZ camera will directly turn to the  
Preset Point direction and CMS will immediately show the image of Preset 
Point.   

 

 
� Start Autopan & Stop Autopan 

Click “Autopan Start” to activate PTZ auto-pan function while clicking “Autopan  
Stop” to stop PTZ auto-pan.  

 
When user adjusts the PTZ control, it will not only change camera image but also 
effects the recording result. CMS can support 128 preset points. 
 

 
 
 
 

Zoom Out 

Zoom In Focus Near 

Focus Far 

Auto-Focus 

PTZ Speed 
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4-1-4 Digital Zoom 
Like PTZ control function, Digital Zoom function only works on single channel view.  
Double click any split channel in CMS monitor and the digital Zoom control panel 
will show up in the right side of CMS main monitor as below.   

 

 
There are two ways to Zoom in and Zoom out image. One is directly select any Zoom 
value from 100% to 1600% in the control panel. The other one is clicking “Zoom in” 

 tab in control panel and click any place of image in the live window step by step 
to zoom in camera image from 100% to 1600%. You can see the zoom-in area in 
preview window marked in red frame. By moving the cursor, you can change the 
zoom in area. On the contrary, you can zoom out the image by clicking “Zoom out” 

tab and click any place of image in the live window step by step.     
By right clicking the mouse in the live window, it will pop up a control menu as 
below.  

 

Below is the description for each function.  
Function Description 
Zoom in Like clicking “Zoom in”  tab in control panel to start to 

zoom in image.  
 Zoom out Like clicking “Zoom out”  tab in control panel to start to 

zoom out image.  
 Original Size Back to the original size  

 Exit Digital Zoom Mode Back to the multiple split mode 

Digital Zoom Control Panel 
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4-1-5 Two Way Audio 
People in CMS server site can directly talk with the people in video recorder site by 
the function of Two Way Audio. Before enabling this function, you should make sure 
the both CMS server and video recorder are installed with microphone and speaker.  
 
 

� At Video Recorder Site 
Turn on the “Live” audio in main monitor. Please refer to the Video Recorder  
user manual. 

 
� At CMS Site 

Step 1 Right click mouse on any DVR in DVR list control window and it  
will pop up a menu as below. Click “Two Way Audio”.   

 

 

Step 2 Click “Start” tab to build up the two way audio connection between  
CMS and video recorder.   

      

 
 
While the connection is built up, it will show the “Connected” in the “State” 
option in the connection window and you can start to talk to the people at video 
recorder site. 
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Click “Stop” tab, to close the Two Way Audio function. 
 

4-1-6 Remote Trigger DO Alarm 
While people in CMS server site see the emergency event in video recorder site from 
the monitor, he can remotely trigger alarm output in video recorder. Right click mouse 
on the video channel and it will pop up a control menu as below.         

 
 
Click “DO Control” option and it will pop up a menu as below. Select any DO device 
to trigger alarm output by selecting alarm output duration and click “Trigger” tab. 
Then, video recorder at remote site will start to trigger alarm output.   
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4-1-7 Minimize & Maximize CMS Window 
By clicking the upper right button  of the CMS window, you can minimize the 

CMS window as the CMS icon  showed in the bottom of 

Window desktop. You can click the icon to back to the CMS widow. 
 

4-2 Display mode 

There are 10 kinds of Split modes and 3 kinds of Sequencer modes in display mode. 
The Split modes include 4 splits, 6 splits, 8 splits, 9 splits, 10 splits, 13 splits, 16 splits, 
25 splits, 36 splits, and 64 splits. The default option is 64 splits   

 
 

4-2-1 Sequencer Mode 
CMS provides three kinds of Sequencer Modes, Single channel, 4- channel and 

16-channel Sequencer. When you click Sequencer icon , it will show the menu for 

your selection.  
 

     
 

� Sequencer Setup 
Before enabling the Sequencer mode, you should have the Sequencer setup in 
advance.  

1) Step 1 Enter the “Setup” option to go to “Sequencer Setup” menu 
2) Select Sequencer Split mode-1, 4 or 16 splits 

For example, select 4 split. 
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3) Click any split block and click “OK” to proceed the setting 
For example, select 1st split Block. 

 
 
4) Assign DVR channels to have the sequencer in this split  

Select the DVR in DVR list and it will show the camera list of the selected DVR 
in the window. 

        
 

Clicking the empty field of the camera in “Select” column to select the camera to 
have the sequencer display in this Split block. Then, the field of selected camera 
in “Select” column will turn to “Y”. 

 

Sequencer Split Mode 

Select Split Block 

Select DVR 
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Enter the display duration of the selected camera and click “OK”. 

     
 

5) Adjust the Sequencer display order by clicking “UP” or “Down” tab and 
click “Ok” 

 

 
Then, the Split block you set can be displayed in sequencer according to your 
setting. You can repeat above steps to set other Split block for Sequencer.  
 

! 
Note 
� You can assign different DVR channels to display sequencer in the 

same Split block.  
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� Sequencer Mode 
 

 
 
After finishing the Sequencer Setup, you can start to select the sequencer mode of 
1-Ch, 4-Ch or 16-Ch Sequencer.  
 
You can Drag & Drop any channel to the Split Block. If the Split Block has been 
assigned the Sequencer channel, it will display the dragged channel in that Split block 
for a while according to the duration you set for that Split block and return to display 
the assigned sequencer channels again. However, if the Split block has not been set 
any channel for sequencer, it will keep displaying the dragged channel in that Split 
block.            
  

 

 
If any camera is disconnected, the sequencer will skip over it to the next connected 
camera channel.  

If you want to exit the sequencer mode, you can press “ESC” or click  to end the 

sequencer mode. 

Drag & Drop 
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4-3 Setup 

   

When you click the setup icon , you can see the following Setup menu. 

 

  

 

4-3-1 DVR Setup 
 

4-3-1-1 DVR Configuration 
Click DVR Setup button to set up the DVRs that you want to control from remote 
CMS. Then, it will show the following screen.  

 

Setup 
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� Add remote DVR 

Click  button to add new DVR which you want to control from CMS. The 

system will appear a dialog box to prompt you to enter “DVR Name “, “IP Address”, 
“Port”, “Username”, “Password”, “Network bandwidth”  and “Image Quality”. 

The DVR’s Name shown in the CMS doesn’t need to be the same with the remote 

DVR’s name. That means CMS Supervisor can create a new name for DVR in the 
CMS site. In addition, Supervision also can name the new names for all cameras 
connected to the remote DVRs in the CMS site. All of these new names are just for 
CMS site and it won’t change the names in DVR site.   

 

�

�

After finishing adding new DVRs, it will show the selected DVR information 
including connected cameras and DVR configuration when you point one of the DVR 

in the DVR list.  
 

A) Network Bandwidth 
You can adjust network transmission bandwidth based on real speed status, just 
select “768K”, “1M”, “1.5M”, ”2M”, “4M”, “8M”,“10M” or “unlimited” for 
adjustment on the ComboBox. If you use company’s or school’s LAN, we suggest 
you can choose “10M” for quick display. For ADSL , Cable Modem , and Dial-up 
service , please adjust the setup based on real ISP speed.  
 

B) Monitor Quality 
CMS support three monitor quality settings,“Low”, “Medium” and “High”. We 
suggest you choose “High” for higher image quality. However higher quality will 



 
 

 
 

24 

occupy more system resources, network bandwidth, and it will result in low display 
speed.  
The setting of each Image quality: 

*Low: 3 Kbytes/FPS 
*Medium: 6 Kbytes/FPS 
*High: 12 Kbytes/FPS 
 

C)Network Saving Mode 
If “Network Saving Mode” is enabled, DVR will only send the video streaming of 
the channels displayed in the CMS split window to CMS server to save network 
bandwidth. We suggest to “Enable” Network Saving Mode to save network 
bandwidth.    

 

D)DVR Active 
Each DVR has remote monitor function. If you want to execute remote monitor, 

please tick “Enable” in the . If you don’t need it, please just get 

rid of the “Enable” button. 

After finishing the setup or modifications, click  button to save the DVR 

changes. 

�
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E) DVR Remote Setup 

You can click Setup icon  to have the remote DVR configuration in detail. 

However, you should verify if “Remote Setup” function in DVR site has been 
enabled. (Please refer to DVR user manual to “Enable” the “Remote Setup” 
function) All of the remote setup functions are similar to the DVR system 
configurations.    

 
 

When you click setup icon , it will show the following screen.  

You can have the “Record Setup”, Create or Edit “User” account, “Alarm” setup, 
“System” and “ Network” setting. Please refer to DVR User Manual to have 

detail setup for each items. After you finish the remote setup, click  

button and press  button to exit the remote setup mode. 

 

DVR advance setting 
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� Delete Remote DVR 
You can also delete any remote DVR controlled in CMS. Just select the DVR in 

“DVR List” and then click  button. 

 

� Refresh remote DVR 

After modifying DVR configurations, you can click Refresh button to 

update the configurations. CMS will keep the latest setup status automatically. If there 

is any remote DVR disconnected, the system will show it as disconnected status  

in DVR List. 

 
 

 

4-3-1-2 Alias Name 
You can click the button of “Alias name” to set up Alias name for camera, DI and DO. 
After you enter alias name for each camera, DI and DO, click “Apply” to save the 
names that you have set up.  
 

 

Enter Alias Name for 

each camera 

Setup Alias name for 

Camera/DI/DO 

Set up Alias Name 
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4-3-1-3 Event Activation 
CMS provides two kinds of alarm notifications, “Alarm Popup” and “Alarm Audio” 
when the events are activated from Camera, DI and DO.    
 

 

 
� Camera Event configuration: 
� Motion Detect: 

� Enabled  
� Alarm Popup Support 

� Motion  
� No Signal 
� Capture Fail 
� Ext Message Support 

 
Once video recorder detects motion, no signal or capture fail, CMS server will pop up 

message to remind “Administrator” for quick response.    
 
You can define “Popup message” in “Ext Message column”, for example, contact 
information, address, etc. 
 
� Alarm Audio Support 

� Motion 
� No Signal 
� Capture Fail 

Event Activation 

Add Popup Message 
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Once video recorder detects motion, no signal or capture fail, CMS server will trigger 

alarm audio to remind “Administrator” for quick response. 
 

You can define the alarm audio when the event occurs. Go to the “Environment 
Setup”(Please refer to the 4-3-2 CMS Environment Setup) and click “ Alarm 
Audio” to set up the alarm audio.  

 

 
You can also set up the Alarm Mode. The alarm configuration are applied for “All 
event from DVR” or “Current monitor camera”  

 

 
� Save to Log 

� Motion 
� No Signal 
� Capture Fail 

Save the events to Log so that Administrator can look up any time. 
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� DI/DO Event configuration: 
� Alarm Popup Support: 

� Enabled  
� Ext Message Support 

� Save to Log 
� Enabled 

 
CMS can show “Alarm pop message” and save the event to the log when DI or DO is 
triggered.  
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4-3-1-4 Health Status 
CMS Server can remotely check health status of video recorders including HDD 
status, camera status and system status.     

    
 

4-3-2 CMS Environment Setup 

When you click the setup icon , you can see the following Setup menu.  

 

 

Click “CMS Environment Setup” to do CMS Environment Setup. 
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4-3-2-1 General Setting 
� DVR Connect 

A) Retry Times  
When DVR is disconnected, CMS will reconnect to DVR with the retry  
times set here.  

B) Polling Duration 
Set the duration for each reconnection from 10 sec to 7200 sec.  

� Frame Color 
When DVR detects motion, the frame of the motion channel in CMS will be 
marked with the color set up here.  

� Alarm Popup 
Enable or disable “alarm popup” function. 

 
4-3-2-2 Alarm Audio 
You can set up playing different alarm audio when CMS receiving events from DVR 
including Motion detect, No Signal, Capture Fail and DVR Disconnect. The file 
format of alarm audio should be “.wav”.  
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4-3-2-3 Alarm Mode 
You can set up CMS alarm popup and alarm audio triggered by “All events from 
DVR” or just by “Current Monitor Camera”. 

 

  

4-3-2-4 Alarm Notice 
Before you activate “Event to Zoom” function, you should have the “Alarm Notice” 
configuraiton in CMS Environemnt setup menu. Please refer to Chapter 4-6 Event to 
Zoom.  

A) Click “Alarm Notice” tab to set up “Event to Zoom” function. 

   

 
B) Click “Add” button to add “Event to Zoom” rule and it will show the setting 

menu as below. 
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� Rule No: Automatically assigned by CMS 
� Name: Define rule name 
� Status: Enable Event rule 
� Type: Event includes Camera Motion and DI(Alarm) Triggered. When 

CMS receives the notices of Motion or DI triggered from DVR, it will 
zoom in the alarm picture to the selected monitor according to the 
Event Rule.  

� Interval: The interval that Rule is activated again by the same Event. 

 
C)  After finishing the previous step and click “Next” step, it will show the detail 

Event Setting menu as below. 
� Camera Motion->Camera Zoom in 

If you set the Event type as “Camera Motion->Camera Zoom in” in 
previous step, it will pop up the menu as below.  

 
 
� DVR List: In the field of “DVR List”, select any DVR that CMS 

receive the Camera Motion notice from and will trigger “Event to 
Zoom” function.     
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� Duration Time: Set the duration of zooming-in motion picture to the 
screen. 

� Camera Status column: Click any cell in the camera status column to 
enable DVR “Camera motion” to trigger zooming in selected camera 
motion picture to CMS selected monitor.   

 
In the same Event rule, you can set motion cameras from different 
DVRs to trigger Zooming function. What you need to do is once you 
finish one DVR settings, you can select another DVR in the field of 
“DVR list” and repeat the step of enabling the selected camera status.  

  
�  DI>Camera Zoom in  

If you set the Event type as “DI->Camera Zoom in” in previous step, it 
will pop up the menu as below. 

 
 
� DVR List: In the field of “DVR List”, select any DVR that CMS 

receive the alarm notice from and will trigger “Event to Zoom” 
function.     

� Duration Time: Set the duration of zooming-in alarm picture to the 
screen. 

� DI/Camera Status table: Click any cell in the DI/camera Status table to 
enable DVR “ alarm (DI)” to trigger zooming in selected camera 
picture to CMS selected monitor.   

 
In the same Event rule, you can set selected “alarm (DI)” to trigger 
zooming in selected camera picture from different DVRs. What you 
need to do is once you finish one DVR setting, you can select another 
DVR in the field of “DVR list” and repeat the step of enabling the 
selected DI/Camera status. 
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D)  Assign the display monitor: Then, you can set the display monitor for the 

triggered Event.  Please refer to Chapter 4-3-3 “CMS Multiple Screen Setup”. 
When you click the field of “Screen ID”, it will show the CMS monitor list. 
Select any monitor for the Event rule and click “Ok” tab.    

 

 
Then, you can see the Event Rule in the Rule List Window. Click any Rule in Rule 
List Window and the detail rule content will list in the Rule Content Window as 
below.   

     

  

4-3-3 CMS Multiple Screen Setup 

When you click the setup icon , you can see the following Setup menu.  

 

Rule List Window 

Rule Content Window 
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CMS Server supports the function of multiple monitor displays and the max number 
of display screens is 16. From the picture below, you can see that you just need to use 
one PC system running one CMS software but can display different CMS screens in 
different monitors. To make this function works, you need to install VGA card with 
multiple outputs. The number of outputs of the VGA card that you install depends on 
the number of monitors that you want to have.    

 
 

 
 
Click “Multi-screen Setup” tab to start to set up Multiple Display function and it will 
show the window as below.  
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Click “Add monitor” and it will pop up a dialog box to let you set up the name of 
CMS applications which you want to display on the monitor. 

 

 
Then, all of CMS application you add will be listed in the left column of the menu as 
below.   
By clicking any cell in the left column of the menu, you can assign the CMS 
application to the Monitor. The number of monitors listed in the menu will depend on 
the VGA card installed in CMS server. 
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After finishing the multiple screen setup, you can see CMS applications displayed in 
multiple screens. Because each CMS application is independent, you can separately 
operate it to different mode according to your requirement.      

 
Note:  
� We only support VGA card with Nvidia chipsets. 
� E-MAP & Playback monitor is either one and can be only activated in main 

monitor.  
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4-4 Snapshot 

  

When clicking the left button of the mouse on the snapshot icon , you can capture 

the image of whole screen. 

 
 
Click “Save” and it will show the following dialog box. Select the folder you want to 

save the Snapshot picture and click “save”. The file is JPEG format.   

 
 

 

Snapshot 

Save 
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4-5 Full Screen 

 

  

 

Click the “Full Screen icon” , you can enlarge any monitor to full screen. If you 

want to go back to main monitor screen, please press the “Space” to get back. 
 

4-6 Event to Zoom 

 

 
When Event to Zoom function is activated, the camera live image will be popped up 
to the CMS screen when CMS server detected the events from DVRs There are two 
modes for Event to Zoom. One is Event   
By clicking the icon of “Event to Zoom”, it will show two types of Event to Zoom for 
selecting. One is Event to Zoom (Auto) and the other one is Event to Zoom (By Rule). 
� Event to Zoom(Auto)  

When CMS server detects any DVR channel with event (motion or DI trigger), it 
will pop up the live image to the split window. The latest    

 
 
� Event to Zoom(By Rule) 

When you select “Event to Zoom(By Rule), CMS server will pop up live image to 
the monitor according to rule set in “CMS Environment Setup”. Please refer to 
Chapter 4-3-2-5 Alarm Notice. There are 1 single channel, 4- split and 8- split 
modes for selection.   
When you click “8-split mode”, it means CMS can simultaneously show eight 

Full Screen 

Event to Zoom 
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Events in the monitor. You can also click “Full Screen” icon to enlarge the Event 
Zooming picture to full screen.    

 
By clicking right button of the mouse on any channel, it will show a display setting 
menu as below. Click “Event to Zoom” and click “Lock”. The selected channel will 
keep to be displayed in the screen until you click “unlock” function.   
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4-7 Playback 

 

 

If you want to see the recording video,�click the playback button  to see the 

following screen. 
 
 
 

 
 
 
 
 
 
 

[Start to Playback] 
(1) Select a date on the calendar. 

(2) Click  button to select playback split mode. There are 1, 4 and 16 channel 

split modes. 

Digital Zoom 

Playback 

Calendar 

Time Search 

DVR Option 

Time Tree 

Time Map 

Playback Channel 

Event Search 

Split Mode 

Download File 

Snapshot 

Full Screen 

Playback Control Panel 
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(3) Click  button to select the playback channels and it will show the 

following Window for selecting the playback channels. You can individually tick 
the cameras for playback. After selecting the playback channels, select the time 
slot of the video data in the “Time Tree window”. In the “Time Tree Window”, it 
will list all of the time slots with recorded video files.      

              

 

(4) Click  to save the configuration and start to playback according to the new 

configuration.   
(5) CMS V1.62 and above version supports playing the recording data recorded in 

the Daylight saving time. If the recording data recorded in the daylight saving 
time, it will be marked a star 

�
 symbol in the right side. 

 

[Event Search] 
Besides searching the video data via time criteria, you can also search the video data 

according to DVR event criteria by clicking “Event Search” button. The event 

search types include “System”, “Device” and “POS” events and you can refer to the 
definition of each event type in DVR User Manual. 

Time Tree 
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(1) Step 1: Select Event Type: Include “All” event, “System” event, “Device” event 

or “POS” event. 

(2) Step 2: Select Event Date: Select the Event date for searching the video data.  
(3) Step 3: Set the pre-recording duration of the video data for playing.  

(4) Step 4: Click “Search” icon to start the Search and all of the events fit the 

search criteria will be listed in the search window. 
(5) Step 5: Click any event log in the search result window and the “Camera No” 

option will be visible for selection. You can click “Edit” tab to change the 
playback channel.     

(6) Step 6: Click “Save”  icon to save the event logs to a file as txt file format. 

Or you can select any event log and click “Playback”  icon to start to play the 

video data of the selected event.  
 

[Download Files] 

Click  button to download files and the following “File Window” will appear. It 

will list all of the video files in selected day. Tick any file for download or click 
“ ” to quickly select the download files. After finishing the selection, 

click button to start to download files or click  to exit to playback main 

window.        
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[Snapshot] 

Click  button to show the Snapshot Window. If you don’t want to print or save 

certain picture, you just click on that channel to “Hide” the screen. You can click the 

channel again to “Show” the screen. Click  button to print the snapshot pictures 

per channel per sheet by 320*240 resolution or click  button to save the snapshot 

pictures as JPEG files.   

 

 
 
 
 

file window 

Snapshot window 
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[Digital Zoom] 
Playback Digital Zoom function only works on single channel mode.  Double click 
any split channel in CMS playback window and the digital Zoom control panel will 
show up in the right side of CMS playback monitor as below.   

 
 
There are two ways to Zoom in and Zoom out image. One is directly select any Zoom 
value from 100% to 1600% in the control panel. The other one is clicking “Zoom in” 

 tab in control panel and click any place of image in the playback window step by 
step to zoom in camera image from 100% to 1600%. You can see the zoom-in area in 
preview window marked in red frame. By moving the cursor, you can change the 
zoom in area. On the contrary, you can zoom out the image by clicking “Zoom out” 

tab and click any place of image in the playback window step by step.     
By right clicking the mouse in the playback window, it will pop up a control menu as 
below.  

 
Below is the description for each function.  

Function Description 
Zoom in Like clicking “Zoom in”  tab in control panel to start to 

zoom in image.  
 Zoom out Like clicking “Zoom out”  tab in control panel to start to 

zoom out image.  
 Original Size Back to the original size  

Change to Timemap Show the time tree at right side of playback window for 
selecting 

 Exit Digital Zoom Mode Back to the multiple split mode 

Digital Zoom Control Panel 
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[Definition of the Icons] 

 Start to play the video 

 Pause 

 Rewind Speed (�): To reduce the playback speed (0.5X, 0.2X and 0.1X). 

 Forward Speed (�): To increase the playback speed (1.5X, 2.0X, 4X and 8X). 

 Previous 1 min: To rewind 1 minute. 

 Next 1 min: To forward 1 minute. 

 Playback with audio. This icon is only enabled in single channel playback or 

digital zoom. 

 Playback event search 

  Select playback split mode (1, 4 and 16 channel split) 

   Save video clips (Download files) 

   Save JPEG files (Snapshot) 

   Enlarge to full screen 

 Select playback channels. 

    Digital Zoom 

    Time Search 
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[Minimize Playback Window] 
 

 
 
By clicking the upper right button  of the Playback window, you can minimize the 
Playback window as the Playback icon showed in the bottom of Window desktop. 
You can click the icon to back to the Playback widow. 
 

4-8 E-MAP 

 

 
 
 
Before you start to enable the EMAP function in CMS, you need to create EMaps in 
EMAP Editor. Click “Start” on your Windows taskbar, select “Programs” and then 
find the folder of “Central Manager”. In this folder, please click the “E-MAP Editor” 
to open the EMap editor and it will show the following dialog box. 
 

EMAP 
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Please select the CMS User Profile with EMAP function and enter the password to 
open the EMAP Editor (Only the administrator is authorized to create the E-MAP). 
Once you set up the EMAP profile in the EMAP Editor, you can start to use EMAP 
function in CMS manager. You just click EMAP icon in the CMS main menu.  
 

4-8-1 EMAP Editor 
When you successfully open the EMAP Editor, you can start to build up EMAP. 
EMAP Editor provides the functions that enable user to set up the locations of 
Cameras in the E-Map to help the administrator to have the connection between 
camera and Map. The MAP supports hierarchy structure and can let administrator 
easy to manage the remote cameras and DVRs.  
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� EMAP Format 
� Map should support JPEG or BMP format. 
� The size of map should not exceed 1024*768.  
 

� Create EMAP 
Step 1 Load/Add EMAP:  

Click “Add” icon  to load MAP into the E-MAP Editor and it will show the 
following dialog box. 

 
 

Click “ Load” icon  and it will show the following dialog box. Select the 

MAP you want to Load and click open.  

Load/Add EMAP 

Delete EMAP 

Edit EMAP 

Camera List 

MAP List 

DI List 

DO List 
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You can see the MAP in the Preview Window. Enter the MAP Name and click OK. 

 

 
Then, you can see the MAP loaded into the EMAP Editor, the MAP name in the MAP 
List and Camera, DI and DO devices in DVR List Window. .  

 
 

MAP Name Camera/DI/DO 
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Step 2 Add Cameras/DI/DO in the MAP 
Click icons of “ ” in front of the camera, DI and DO devices in DVR List Window 
and all of the devices connected to this DVR will be listed.  
 
By “Dragging and Dropping” any camera, DI or DO icon from the DVR List window 
to the MAP and it will prompt the dialog box below to ask you to select the camera or 
DI/DO icon that will show on the MAP.   

 

 
 
There are 8 camera direction types and you can select any type according to the 

direction you want to show in the MAP. If it is PTZ camera, you can select  
icon.  
 

     

  
 

Camera DI/DO 

Drag & Drop 
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You can also adjust camera location in the MAP by just dragging the camera icon in 
the place you want to put.  
 

 
 
The camera, DI and DO devices put on the MAP will be listed in the MAP List 
Window. MAP List is managed in Tree View. You can click “ Edit”, “Del” or “ Add” 
button on the bottom of MAP list window to edit, delete or add MAP.   
 
 
You can also click the left button of mouse on any MAP in MAP List window, it will 
pop up a menu as below,    
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Function  Description 

Up  Move up the MAP 

Down  Move down the MAP 

Add  Add a new MAP under this MAP 

Del  Delete MAP 

Edit  Edit MAP. You can edit MAP name or reload a new MAP. 

Expand  List all of camera, DI or DO devices in this MAP  

Collapse  Hide the list of the camera, DI or DO devices in this MAP  

 

! 
Note 
� Camera, DI and DO icons shown in gray color mean that camera, DI and 

DO devices are not put in MAP yet. 
� If you change the installation of DVR channels or alarm IO channels in 

DVR side during editing the E-MAP, you should be back to CMS main 
menu and do “ Refresh connecting” by clicking right button of mouse to 
get update devices (Camera or Alarm device) shown on the E-Map Editor. 

 
Step 3 Save the EMAP 
Once you finish the EMAP configuration, please make sure to save the settings by 
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clicking the “Save” in the “File” menu and click “Exit” to close the EMAP Editor. 
 

 
 

4-8-2 EMAP Operation  
After finishing EMAP configuration, please open and login to Central Manger system. 
 
� Activate EMAP 

Click the EMAP icon  in the CMS to activate the EMAP function and you can 

see the following screen. 
 

 

There are three statuses of cameras shown on the camera icons as below,  

�Event � � DVR detects camera events of Motion, Mask or No signal. 

EMAP icon 

EMAP MAP List 

Full Screen 
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�Disconnect � � Camera is disconnected. 
�Connecting� � Camera is connecting. 

 
You can directly click any camera icon shown on the MAP and CMS will 
immediately pop up a window to show that camera screen as below.   
 

Click  icon to snapshot the video screen. You can select “ Print” to print the 

snapshot screen or select “ Save” to save it as a file.   
 

 
 
 
 
� EMAP in Full Screen 

If you want to enlarge EMAP to full screen, just click full screen icon  and the 

EMAP will be enlarged to Full screen as picture below. If you want to back to normal 

screen, just click the  icon on the up-right side of MAP List window.   

 

Close Snapshot 
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4-9 Quick Select Tag 

User can define the configuration of Quick Select Tag from the ten options. It means 
that the selected split windows for each DVR and camera at any split mode can be 
saved for next time use. With this Quick Select Tag, you can switch to split window 
fastest and more convenient.  
 

4-9-1 Save Quick Select Tag 
You can save your own Quick Select Tag by clicking . Then, enter the name of 
the Quick Select Tag in the following dialog box. and press “OK” to finish saving. 
 

 
 

You also can select “Default View” in advance, and you can use the selected option 
whenever you initialize the CMS and Auto-Login. 
 

Back to normal screen 
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4-9-2 Delete Quick Select Tag 
 

If you want to remove the unnecessary selected options, please select the Quick Tag 

you want to delete on the combobox, and press  to delete the Tag. 

 

4-9-3 Rename Quick Select Tag 
 

You can click Rename icon  to rename the name of Qick Select Tag.   

4-10 Log System Status Window 

You can see the DVR status from the Log System Status Window.  

�

�

� Camera Event: show the cameras with motion events.  
� Connecting Status: show all DVR connecting status. 
� DVR Status: show DVR status. 
� Channel Status: show each channel status. 
� Connecting Log: show each connecting log. 
� Log Search: Search the event log 
You can query the events according to time, event type, time, camera and DVR.    

 

Set up Event type, Time, Camera and DVR and click “Go” to list all of the event logs 
which are within the conditions you set up.   

 
Select one of the event log and click “ Playback” to playback the video of this log 
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which you query directly. 

 

 
 

Select the log and 

click playback  
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4-11 Central Backup 

CMS Central Backup function enables administrator to back up local DVR files 
from remote side. Administrator just needs to select the camera, time and storage 
device and then can execute backup.        

4-11-1 Execute Central Backup program 
Click “Start” on your Windows taskbar, select “Programs” and then find the folder of 

“Central Manager”. In this folder, please click the “Central Backup” to execute 
backup program and it will show the following dialog box. 

 

 
� Log in 
Please select the CMS User Profile which you want to execute the backup. Because 
only administrator has the authority to back up DVR files, please open the User 

Profile by entering administrator’s password to login to the Central Backup.  
 

4-11-2 Set up Backup Schedule 
If DVR in the DVR list isn’t scheduled for backup, it will show “No Backup 
Schedule Setup” in the left window of “Backup DVR Information”.  
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Click “File>Backup Schedule Setup” in task list to start to arrange the DVR backup 
schedule. It will show the following dialog box. Select DVR to create the backup 
schedule and click “Modify schedule” in the left bottom of window.   

 
 
Then, it will show the following window. 

� DVR File List 
Click each camera and it will spread all of the video files naming by date.  

� Backup Camera 
Select the cameras for backup. 

� Schedule 
There are two types of backup schedule. One is backup by “Once” and the other one 

DVR List 
Backup 
information 

DVR 
Backup 
status 

Task List 

Modify 
Schedule 
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is by “Periodical”.  

� Target Directory 
Select the directory to save the files. You can choose the directory of local HDD or the 

Network Drive(NAS).  
   

 
 

 

� Bandwidth Limit 
Set up the maximum bandwidth for backup. “0” means no limitation.  
 

4-11-3 Functions in Task list 
� Action>Suspend: Stop the backup task. 
� Action>Resume: Restart the backup task. 
� Options>Bandwidth Limit: Set up the limit of the total bandwidth and the 

maximum number of downloaded files at the same time. 

� Options>Alarm: Set up alarm for HDD remaining size. When the remaining 
HDD space is smaller than the file size set here, the system will send an alarm 
audio to warn the administrator.  

� Options>Recycling: Set up the HDD recycling size. When the remaining HDD 
space is smaller than the size set here , the system will start to do the recycling. 

� Options>Login: When power fails and you restart the system, it will login by 
using these setup values. 

� File>Files check: This function provides you to check backup status. 
(1) “Lost”:   Check whether the files that you download are lost. If the files are 

lost, they will be recorded as “Lost”. 

DVR File 
Date List 

Backup 
camera 

Backup Schedule 

Backup 
Directory 

Bandwidth 
Limit 
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(2) “Not Found”: The file has been scheduled to be backed up and backup is not 
finished. However, you can’t find this file in DVR any more. Then, this file 

will be recorded as “Not Found”.   
(3) “CRC Error”: The size of backup file is not the same as the one in DVR. 

Then, this file will be recorded as “CRC Error”. 
(4) “Recycle”: Files are successfully backed up but these files are overwritten 

(Recycle) because the remaining HDD space is not enough. Then, this file 

will be recorded as “Recycle”. 
 

        
 

After finishing the “Files check” and finding the incomplete files (Lost, Not 
Found, CRC Error), the system will show the following dialog box. User can 
decide to download these incomplete files again or ignore these files. If user 
decides to ignore these files, the system will not mark them as incomplete file 

any more when he executes “Files check” next time.    
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4-11-4 Backup Information 
� DVR Backup status 
Click any DVR in DVR list to see the total DVR backup status including backup 
settings, total backup files, backup size and remain sizes as the following picture.  

 

 
� Camera Backup status 
Double click the DVR in the DVR list and it will list all of the cameras connected to 
this DVR. Click the camera to see the backup statistics of this camera as the following 
picture.     
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� File Backup status  
Double click the camera in the DVR list and it will list all of the dates with 
recorded files. Click any date and it will list all of the backup files in this date 
and the status of backup file.   

 

 
Double click any file in this backup file list to activate DVR player to play the 
file. Click the right button of mouse on the file and it will show the directory of 
the file.  
 

In the column of Schedule Status, you can see six types of file backup status. 
(1) Complete: Complete the downloading file. 
(2) Incomplete: File download is not completed. 
(3) Not Found: File can’t be found in DVR. 
(4) Deleted: Complete the file downloaded but file has been deleted by user. 
(5) GC: File is downloaded but overwritten due to HDD recycling. 
(6) Wait: File is not downloaded. 
 

� The state of DVR Backup task 
In the bottom of window, it provides the various information including Backup 

Task “Current Status”, “System Log”, “Connection Log”, “ Storage 
Information” and “Network Statistic”.   
In the “Current Status” mode, there are 9 kinds of state in the column of 
“STATE” shown as following picture.   
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(1) Sleep: It’s not the time to start the backup task. 
(2) Wait: It’s time to start the backup task but the number of total backup tasks is 

over the one you setting. 
(3) Download: Files are being downloaded. 
(4) Finish: Backup task has been finished but it doesn’t mean that all files are 

backuped. It is possible that some files are not backuped because they are 
overwritten due to DVR recycling.   

(5) Suspend: Stop the backup task. 
(6) Error: There is an error during the downloading files. Please check logs. 

After fixing the error, please restart this task. 
(7) Disk Full: Disk is full and can’t execute backup.  
(8) Disk Error: There is an unknown error happening in the disk. Please check 

the disk.  
(9) Empty: There is no file to be downloaded in the arranging schedule. 
 

In the “Network Statistic” mode, it will show the current network flow as 
following picture. “Download Speed” is current average download speed. 
“Total Download” is calculating the total download file size. When you click 
“Reset Statistic” icon, the number of “Download Speed” and “ Total Download” 
will be reset to “0”.   
 

 
 
 
 
 
 
 
 
 
 

Task state 
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! 
Note 
Bandwidth Limitation  
� Individual task bandwidth can’t exceed total bandwidths. 
� If all of the task bandwidths are set as “ No Limit”, the tasks will 

averagely share the bandwidths. 
� If the total task bandwidths are larger than total bandwidth, all of the tasks 

will share the total bandwidth according to the proportion. 
� If not all of the task bandwidths are set as “ No Limit”, the bandwidths 

will be assigned to the tasks that are already set in advance according to 
the proportion and then the rest of bandwidths are assigned to the tasks set 
as “No Limit”.        

Others 
� Backup log files are saved in the directory of CMS and named as 

“ RBLog.mlb”. 
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4-12 Use Local Playback 

In the playback mode, you can download the video files (Chapter 4-7-2) by clicking 

the  and save the files in the directory. The files you download are CX3 format. 
If you want to play the video file, you must execute “DVR Player” from Windows 
taskbar->Start-> Program-> CMS folder. 
 

 

 

� Click the  on the left down of the screen to open the video file and it will 
show the playing options as following,  

 Playback  

 Pause 

 Stop and go back the beginning of the film. 

� AVI Format Export: 
This function provides you to transform the download files from CX3 format to 
AVI format.  
� Open a download file.  

� In the “Tools’ bar, select “ Convert to AVI” and then select the path you 
want to save the AVI file and key in the AVI file name. 
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� Select the transforming format. Here we choose Microsoft MPEG 4 Video 

Codec.  

 

� Select transforming parameters and it will influence the file’s quality and 
size. 
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� Enter “ OK” and then it will show the transforming status. 
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5. Appendix 
 

5-1. Maintenance 

� Avoid placing the system at high temperature, high humidity , and also keep 
away from working in the frequent vibration environment.  

� Operate the system under the conditions of stable and high voltage, If possible, 
the system should be equipped with UPS ( Uninterruptible Power Supply ).   

5-2. FAE Support 

Any questions, please contact your supplier for your service. 
 
   


